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Dear Customer,

Thank you for choosing a DigiTrak guidance system. We are proud of the equipment we have been designing
and building inWashington State since 1990. We believe in providing a unique, high-quality product and
standing behind it with world-class customer service and training.

Please take the time to read this entire manual, especially the section on safety. Please also register your
equipment online at access.DigiTrak.com. Or, fill in the product registration card provided with this
equipment and either fax it to us at 253-395-2800 or mail it to DCI headquarters.

Product registration entitles you to free telephone support (in the USA and Canada), notification of product
updates, and helps us provide you with future product upgrade information.

Our Customer Service department is available 24 hours a day, 7 days a week in the U.S. to help with
problems or questions. International contact information is available in this document and on our website.

As the horizontal directional drilling industry grows, we’re keeping our eye on the future to develop equipment
that makes your job faster, easier, and safer. Visit us online any time to see what we’re up to.

Wewelcome your questions, comments, and ideas.

Digital Control Incorporated
Kent, Washington
2017

Watch our DigiTrak Training Videos at www.youtube.com/dcikent

http://access.digitrak.com/
http://www.youtube.com/dcikent
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Important Safety Instructions

Always operate your DigiTrak locating system properly to obtain accurate depth, pitch, roll, and locate
points. If you have any questions about the operation of the system, please contact DCI Customer Service
for assistance.

This manual is a companion to your Falcon F5® guidance system operator's manual, which contains amore
thorough list of warnings regarding the potential for serious injury and death, work slowdowns, property
damage, and other hazards and warnings regarding the operation of horizontal drilling equipment. Please read
and understand your system operator's manual completely before operating the equipment described in this
manual.

Data that is logged, displayed, stored, and used by the Falcon F5 receiver and LWD 3.04
software is not guaranteed to be accurate or complete. Human review and judgment is required.
The accuracy and completeness of data generated by HDD guidance systems may be affected by
active or passive interference and other environmental conditions, failure to calibrate or use the
device properly, or a variety of other factors. DCI does not warrant or guarantee, and disclaims
liability for, the accuracy and completeness of any data generated by any external source,
including (without limitation) GNSS data and data received from a drill rig.

Compatibility
LWD 3.04 can openmost jobs saved in prior versions of LWD. LWD 3.04 files (extension lwd), however, are
not backwards-compatible with LWD 2.12, which uses files with the dl5 extension. Additionally, iGPS data
will not display in LWD 3.02. An older file that is opened and saved in LWD 3.04 becomes an lwd file that can
no longer be opened in older versions of LWD. Contact DCI Customer Service for information on upgrading
2.12 or 3.02 software to version 3.04.

LWD 3.04 is not compatible with legacy F5 TensiTrak files, TensiTrak fluid pressure files, or files generated
by an Eclipse or Mark Series receiver. To view these legacy files, continue using LWD 2.12.
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Falcon F5 DataLog

The DataLog® feature on your receiver lets you capture and store the rod-by-rod data of your pilot bore. When
used with our mobile phone app LWD Mobile, using DataLog while drilling lets you view a real-time plot of
your bore in progress right on your phone, as well as geo-tag the entry and exit. If you use the DigiTrak Aurora
remote display, its LWD Live app also lets you view the drill profile in real-time as each rod is completed,
whether DataLog is enabled on the receiver or not.

In addition to the rod data DataLog has always captured, with Falcon F5 we’ve added features like left/right
offset and deviation, which let you record with even greater detail precisely where your pilot bore is in relation
to surrounding landmarks. Increasingly, this data is also required by the client to ensure drilling parameters
weremet. When you import your DataLog job into our Log-While-Drilling (LWD) 3.0 software for your PC, you
can edit, annotate, and create the precise report you or your client requires.

Introduction
The DataLog feature canmeasure and record the following types of data:

l Rod number
l Depth
l Pitch
l Offset
l Deviation from running line
l Flags and pins
l Elevation change (surface topography)
l Fluid pressure (requires a fluid pressure transmitter)

The terms and techniques used in this manual are considered basic to the DigiTrak Falcon F5 locating
system. Youmust read and understand your system operator’s manual and familiarize yourself with the
various DataLogmenus on your receiver before using the system. If you have questions, please call DCI
Customer Service for assistance.

How It All Works
Turning your HDD job into a concise LWD graph consists of the following steps, which are covered in detail
later in this document.

Before uploading a DataLog from your receiver for the first time, you will need to install LWD 3.04 on your
PC, along with the Bluetooth radio (mini Falcon) drivers, and enter the receiver serial number and
Bluetooth ID.

1. Enable DataLog on your receiver (it ships from our headquarters ON by default).

2. Create a new job, set optional offset and deviation, and start recording.

3. Log full or partial rods, remove rods (pullback), or insert flags or pins before pausing or closing the
job.
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4. Select the job to upload from your receiver, then either:
l Upload it from within LWD 3.04 and annotate or edit the job data as required, or

l Upload to your smart device using LWD Mobile to display all drilling data and even the drill
profile in a read-only format right on your device.

5. If you uploaded to your smart device, you need a subscription to transfer the job to your DigiTrak
Cloud account (optional). Once there, it can be accessed and edited in LWD 3.04 from any
computer with internet access.

To link your receiver to a cloud account andmanage subscriptions, go to www.MyDigiTrak.com.

Download the free LWD Mobile app for your smart device from the Apple Store or Google Play and read the
user guide located at the Falcon F5 operator manuals website. Refer to our Aurora page online for more
information on the LWD Live app.

DigiTrak DataLog Management (DDM)
DataLog and Log-While-Drilling are parts of DCI's complete datamanagement process. For more
information, visit us online.

On the Documentation page of our website (Service & Support > Documentation), under Manuals, select
Falcon F5 from the drop-downmenu and scroll down to the section on related User Guides for information on:

Cloud Manager Store andmanage your DataLogs and Log-While-Drilling (LWD) files
from all your receivers in one convenient place.

iGPS AddGNSS latitude/longitude coordinates to every data point with this
optional Falcon F5 add-onmodule.

LWD Live Watch your bore plotted in real time on your Aurora® touchscreen
display. Import a Vermeer BoreAssist file.

LWD Mobile Use your smart phone to upload a Falcon F5 DataLog to your
subscription cloud account for instant viewing and analysis company-
wide.

Setting Time and Calendar
The correct time and datemust be set on your receiver before logging data. The option to set the time and
calendar is available on theSettings option on theMainmenu. For additional help on setting the time and
date for your receiver, consult your operator’s manual.

http://www.mydigitrak.com/
http://www.digitrak.com/component/content/article?id=271:falcon-f5-manuals
http://www.digitrak.com/CustomerService/Downloads
http://www.digitrak.com/support/WebHelp/Cloud_Manager
http://www.digitrak.com/support/WebHelp/DataLogLWD-OM/Default.htm
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System Components
The DigiTrak DataLog system has four main components:

Falcon F5 Receiver (FF5) A receiver (locator) with DataLogmenus used to display and record
transmitter data.

Falcon Transmitter A battery-powered device located in the drill head with sensors that
continuously measure and transmit information about the below-ground
drill head. This information is displayed on the FF5 receiver.

LWD 3.04 Software The computer application used for downloading and working with
Falcon F5 DataLog drill data from a receiver

Bluetooth USB Radio A USB device required for the computer to communicate with the
Falcon F5 receiver. Look for theminiature Falcon F5 in your system
case.

Receiver
The receiver tracks the position and depth of the transmitter. With DataLog enabled, it also records drill data
such as depth, pitch, and rod number. The Falcon F5 receiver can record and store 50 jobs (runs) before
some or all jobs must be deleted tomakememory available for new jobs. Each DataLog job can have
hundreds of data points.

Transmitter
The Falcon F5 receiver will only work with a Falcon transmitter. The advanced technology used in the Falcon
systemmakes the receiver incompatible with classic DigiTrak transmitters.

Standard drill data provided by a transmitter includes depth and pitch. A Falcon F5 transmitter also provides
fluid pressure readings.

LWD Software
The Log-While-Drilling (LWD™) software is provided on a USB flash drive that also contains this operator’s
manual, the system operator’s manual, sample drill data, and Bluetooth drivers.

LWD 3.04 USB Flash Drive

The software requires a computer with the followingminimum specifications:

l Microsoft Windows operating systems currently supported by Microsoft Corporation
l USB port
l pointing device (mouse)
l printer (optional)
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Bluetooth USB Radio
The Bluetooth USB radio plugs into your computer to allow the receiver to upload data. Drivers for the
Bluetooth adapter are provided on the LWD flash drive andmust be loaded before use; see Log-While-Drilling
3.04 on page 22.

1. Case
2. Radio

Bluetooth USB Radio

Typical LWD Report
The as-built report you view in the Log-While-Drilling program shows the drill data you recorded on your
Falcon F5 receiver. All reports include standard transmitter data like rod number, depth, and pitch. This
screen is discussed in detail in Opening Files on page 25.

DataLog with Fluid Pressure in LWD 3.04
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Custom options while drilling with the Falcon F5 receiver:

l Deviation from running line
l Offset of borepath from a running line or parallel landmark such as a guard rail, curb, or fence
l Pins tomark geographical points adjacent to the bore path
l Flags tomark utility crossings
l Exit elevation

Custom options after downloading to computer:

l Add utilities by color code, type, and depth
l Add features like roads, water, and power poles using annotations
l Add, delete, or modify rods and rod lengths
l Scale the chart for more realistic view
l Add a survey point to show the elevation difference between the entry and exit elevations
l Scale the chart to hide pressure data
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Using DataLog on Falcon F5

To record pilot bore drill data, the receiver must be receiving data from a properly paired and calibrated
transmitter, as described in your receiver operator’s manual.

Enable DataLog
The DataLog featuremust be enabled before you can start recording or append to drilling data.

From theMainmenu, toggle down to the second page and select DataLog .

Falcon F5 Receiver Main Menu, Second Screen

In the subsequent DataLogmenu (next section), if the DataLog icon is red (disabled), select it so it turns
green (enabled). If the icon is already green, DataLog is already enabled.
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Receiver DataLog Menu
Use theDataLogmenu to enable or disable DataLog, set up a job, delete jobs, and perform other DataLog
tasks.

Second page

1. Set up job
2. Upload
3. Delete
4. Enable/disable
5. Survey point
6. View jobs
7. Enable/disable left/right

offset from borepath
8. Enable/disable deviation from

intended borepath
9. Exit

DataLog Menus

Left/Right Offset and Deviation icons are located below the Enable/Disable icon . Select either icon to
turn each feature on (green) or off (red, shown above). Offset and Deviation are discussed on page 15.

Create a New Job
1. At the Locate screen, hold the trigger and toggle right to display theDrill DataLog Start

Recordingmenu (this is the same as selectingSet up job from the receiverDataLogmenu).

2. Select Create a New Job .

1. Create a new job

DataLog Recording Menu
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3. Enter the drill rod (pipe) length to be used for this bore on the keypad, then select Enter to set it
as the drill rod length.

1. Enter

Keypad for Entering Pipe Length

The default rod length is 10 ft. The receiver remembers your last rod length.

4. The 1st rod length input screen appears with a default value. This length is automatically calculated
as 70% of your pipe length. If this is correct for your bore, select to set this value and skip to
the next step.

1. First rod length
2. Set first rod length to default

value
3. Select keypad to enter a

different value

First Rod Length Input Screen

If the drill head cannot be positioned so the slots are half above and half below the ground due
to tooling configuration (as shown in the preceding and following illustrations), you can still
illustrate this later in LWD on your uploaded bore data by opening Job Information (under the
Editmenu) and entering a value in theRel. Elev. (Relative Elevation) At Entry box. For
example, if the housing slots are 4 feet below ground, enter a value of -4.

To calculate a different 1st rod length value, measure from the vices to the top of the rod when the drill
head is positioned for the first data point. For this measurement, the housing slots should be half above
and half below the ground (or a plane parallel to the ground if drilling into a pit). The elevation at the first
data point is the Zero Reference elevation, and is generally at the surface of the ground.
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Select the keypad, enter the desired value, and select Enter .

1. Drill carriage
2. Top of rod
3. First rod length
4. Vices
5. Slots in housing
6. Zero elevation reference line
7. Surface of ground

Measuring the 1st Rod Length

5. When recording the first data point (rod 0), the only available option will beRecord Pitch Only .
With the receiver positioned within range of the transmitter (it does not have to be at the locate line or

front locate point), select to record the data point.

iGPS Note

It is best to record Rod 0 above the transmitter at the entry (#5 above). Record all iGPS data
points with the Falcon F5 above the Locate Line (LL) to ensure proper GNSS records.

1. The – – – indicates offset is
disabled

2. Record pitch only

Drill DataLog Recording Options (Pitch
Only)

6. If Deviation is on (see page 15), select the arrows to enter the horizontal distance the located drill
head is from the intended path (default is the last deviation entered), then select to save and
return to the Locate screen.

7. Advance the drill head to the end of the first rod and position the receiver over the locate line (LL) or
the front locate point (FLP). Hold the trigger to take a depth reading and set a reference point.
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iGPS Note

GNSS data will be most accurate when data is recorded with the receiver over the locate line.
Recording rod data at the FLP will store the GNSS data, but it will be hidden on the LWD
report. This is because the GNSS data at the FLP is not above the locate line, but depths at the
FLP are back-calculated to reflect depth above the drill head. After transferring the DataLog to
LWD on a computer, you will have the option to unhide GNSS data at the FLP.

8. Hold the trigger and toggle right once to view Recording Options, which now has all options
enabled.1

1. Record depth/pitch (shown
withbest iGPS signal quality)

2. Record pitch only
3. Record a blank rod

Drill DataLog Recording Options

When this screen appears, data from the transmitter and iGPS is locked in and youmay move the
receiver. This data remains visible until you record this data or select Exit. Before recording, verify the
rod number, depth, pitch, and offset are correct. If not, toggle down, select Exit (not shown above), and
repeat this step.

iGPS Note

If no green icons (or LED lights on the iGPS module) are solid green, exit and obtain a better
GNSS signal. Try staying in position longer or positioning your body on a different side of the
receiver.

1 This step can be done from the standard Locate screen or the Target Steering™ screen. It is not necessary to toggle out of the
Target Steering screen for these DataLog functions.
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8. Select one of the following to record the second data point (rod 1):

l Record depth/pitch to log depth, pitch, and (with the optional iGPS module)
GNSS information.

l Record pitch only to log only the pitch because you are unable to position the receiver at the
LL or FLP. This is also useful when drilling under rebar, which can lead to incorrect depth and
topography values in the graph.

l Record a blank rod if you have no data because you cannot position the receiver within
range of the transmitter. This is especially useful for highway and water crossings.

9. Optional: if deviation is turned on (see page 15), enter the left or right deviation or a blank, after
which the receiver returns to the Locate screen.

10. Continue drilling, using the trigger/toggle right sequence to record data points and deviation at the
end of each drilled rod.

Resolving Missing Data

If the locator cannot be positioned above the drill head (LL) or at the FLP while toggling right to record a rod,
theRecord Depth and Pitch option will be unavailable and only pitch can be recorded. On the LWD graph
on your computer, a pitch-only reading will produce a gap in topology where depth is missing but will keep the
graphing accurate for the bottom bore profile.

iGPS Note

GPS is not recorded for pitch-only and blank recordings.

LWD will suggest an estimated depth based on surrounding topology, which you can accept or override with
your own value in LWD. After uploading the data, right-click that rod in the data table, select Edit, and clear
the "Depth is Hidden/Unknown" check box. For rods recorded as Blank, depth andmissing pitch can be
calculated by the LWD software or you canmanually enter the proper pitch if known. See Editing Data Points
on page 31.

Recording Partial Rods
The DigiTrak Log-While-Drilling (LWD) program requires data points to be recorded at equally spaced
intervals, such as at the end of each drill rod. However, when drilling with long drill rods and/or making
significant pitch changes, youmay want to record data at partial pipe length intervals to more accurately
depict the bore profile and changes in topography. The LWD function can accommodate quarter, half, three-
quarter, and full pipe lengths. Partial rods may only be recorded after rod 1 (second data point) has been
recorded.

To record a partial or pitch-only rod:

1. Position the receiver at the FLP, or over the LL, or within range of the transmitter for pitch only.

2. At the Locate screen, hold the trigger and toggle right once to view the recordingmenu.

3. Toggle down and select Data at partial rod on the second page.
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1. Rod length (full, 1/4, 1/2, 3/4,
or finish depending on
whether a full or partial rod is
selected)

2. Data at partial rod

DataLog Recording Menu

4. Select a partial rod length.

DataLog Partial Rod Screen

The display returns to the first recording options screen with the partial rod value (¼, ½, ¾, or finish rod)
appearing in place of “Full Rod” (see image in step 3).

5. Select the option to record the data point with depth and pitch (record pitch-only or blank only if you
are unable to position the receiver at the LL or FLP). Record Deviation if applicable. The receiver
returns to the Locate screen.

6. Record another data point at the partial rod length or end of the rod.

The “Finish Rod” option appears if a partial rod was previously recorded.

Flags and Pins
Set a Flag or Pin to include landmark or utilities information with your drilling data (see diagram on page 16).
Flags and pins appear along the top of the LWD graph. View the drawing at the end of this section for a visual
on the use of flags and pins.

Toggle right briefly at the Locate screen to set a flag or pin. Do not hold the trigger in for this
function. A "hold toggle right" is the shortcut to change transmitter frequency bands.
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DataLog Flag/Pin Menu

Flags are numbered sequentially starting at #1 and are tied to a specific rod number. Pins are also tied to a
specific rod, but you enter your own custom pin number. Both flags and pins must be entered before the
current rod is completed.

Lateral position of pins and flags are based on where the current LWD rod number started, based on the
locate line, not the FLP. Even if a partial of that rod has been recorded, the flag/pin will be positioned from the
start of that rod.

Starting with rod 1, each rod in a LWD file shows the X distance (see diagram on page 20), which is
calculated as from the entry to the end of each rod.

On the printed report for flags and pins, each will receive an X Distance so it can be compared to depth
readings on the report.

Flags

Set a Flag when crossing an item of interest along the bore path, like a sidewalk, marked utility line, or
river bank. The receiver internally assigns a sequential flag number starting at 1. Enter the approximate
distance along the current rod; this number will always be less than one rod length, otherwise it would be
assigned at the next rod. The receiver will calculate the total horizontal distance of the flag based on the total
number of rods already logged. Handwritten details are required so they can be entered in LWD after
download.

Flag Set Screen
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Pins

Set aPin to mark the location of a land feature to the left or right of the bore, such as a fire hydrant or
power pole, that can help locate the bore path later. Setting a pin requires three pieces of data that are
entered using the onscreen keypad:

1. An identifying number. Pick a number, any number. Create your own custom
codes, such as 11.xx for fire hydrants, 22.xx for light posts, 33.xx for traffic
light poles, and so on.

2. The approximate distance along the current rod.

3. How far the drill head is to the left or right of the feature.

Offset and Deviation
Both Offset and Deviation (see diagram below) are off (red) when you enable DataLog. To turn either feature
on, simply select the icon so it turns green. Offset and deviation values are listed in the data table but not
depicted on the graph.

Offset

On theDataLogmenu, Offset lets you specify a horizontal distance you intend tomaintain from a
feature beside and parallel to the intended bore path, such as curb, guardrail, or surveyed path. A "right"
offset means the intended bore path is to the right of the feature. Think of this as a "running waypoint" that is

recorded as long as the offset is in effect. Using the onscreen keypad, enter a value, select the Left or

Right arrow, and thenEnter.

Offset can be turned on or off and adjusted to different distances at any rod number. For
example, a curb offset may start at rod 7 at a distance of 10 feet left and end on rod 27. A new
offset of a road edgemay start at rod 50 at 5 feet right and last to the end of the bore.
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Deviation

Also on theDataLogmenu, Deviation lets youmark how far the drill head is deviating from the intended
bore path. A "right" deviationmeans the drill head is to the right of the intended bore path. Do not enter a
deviation based solely on the distance of a front locate point to the left or right of the bore path.

Each time you log a rod at the Locate screen (hold trigger, toggle right), this feature lets you also record your
current deviation. For example, if you locate the drill head slightly to the right of the intended bore path, you

can enter this distance as a right deviation. Using the onscreen keypad, enter a value, select the Left or

Right arrow, and thenEnter.

Deviation also has aBlank option for those rods where locates are questionable or not available.

1. Sidewalk
2. Right offset
3. Right deviation
4. Fire hydrant
5. Pin distance to the right
6. Set pin marking fire hydrant
7. Intended bore path
8. Actual bore path
9. Set flag marking gas line

crossing
10. Marked gas line

Left/Right Offset, Deviation, Flags, and Pins

Closing or Pausing a Job
Keep a handwritten log of the depth, description, rod number, and/or distance from the entry for each item
and add this information to the drill data later in the LWD software on your computer.

DataLog jobs must be closed before they can be uploaded. Close a job after recording the last data point.

You can also pause a job so it remains open while you navigatemenu options. All jobs close automatically
when the receiver powers off.
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1. At the Locate screen, toggle down to open the DataLog Close/Pause Recordingmenu.

2. Select Close Job to close the job. The job can now be uploaded to a computer (see Uploading
Falcon F5 Data to a Computer on page 22) or added to later (see Appending to an Existing Job on
page 17). An open jobmust be closed before a new one can be opened.

- OR -

Select Pause Job to keep the job open. When you return to the Locate screen, your next data
point will record on the same job.

1. Close job
2. Pause job

DataLog Close/Pause Recording Menu

An FF5 receiver can store a total of 50 DataLog jobs. The receiver displays a warning at 45
saved jobs. Trying to savemore than 50 jobs will return you to the Start Recordingmenu where
you can append to a job or exit.

Appending to an Existing Job
UseAppend in the Start Recordingmenu to add data to a DataLog job that has been closed or paused.

1. At the Locate screen, hold the trigger and toggle right once to view Recording Options.

2. Select Append .

1. Appending to an existing job

DataLog Recording Menu
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3. Select the job number to append to. The locator proceeds to the Locate screen.

Sample DataLog Jobs Lists

4. Continue recording rods or partial rods as described earlier in this section. The appropriate next rod
in sequence will be retrieved.

Viewing and Pulling Back (Deleting) Rods from the Receiver
Viewing data from previous rods is useful when a pullback and redirect of the bore path is required.

1. At the Locate screen, hold the trigger and toggle right once to view Recording Options.

2. Toggle down and select View/Delete rod data .

1. View/delete rod data (pull
back a rod)

DataLog Recording Options Menu
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3. In the View RodData List, themost recent rod (the only one that can be deleted) is highlighted in
the top row.

l To return to the Locate screen without deleting this rod (data point), simply toggle left or right.
l To pull back the rod (delete it), click to select it, then select to confirm.

1. Data for most recent rod
2. Survey point (appears blank

unless value is entered under
Survey Point menu option)

DataLog Rod List

Relative depth will be blank and remain so if more than two rods in a row do not have pitch.

For additional information on survey points, see Adding a Drill DataLog Survey Point on page 20.

Depths in green were recorded at the LL; depths in white were recorded at a locate point (LP).

Relative depth (Rel Depth) is a calculation of how deep the drill head is below the drill rig elevation, or
"zero elevation reference line" (see diagram in next section). It is based on rod length and accumulated
average pitch per rod. Relative depth can be negative or positive. Recording a rod without pitch (blank
rod) will result in a blank relative depth value.

A blank (---) relative depth occurs when blank or pitch-only recording options are used.

4. Click to delete the last rod data point, orExit to cancel and return to the Locate screen.

5. Continue these steps for each rod you need to delete, selecting themost recent data point from the
list shown in step 3 and then to delete. When you are finished deleting rods, toggle left or right
in the View RodData List to return to the Locate screen. Ensure that the number of rods deleted
matches the number of rods pulled back.

Measuring and Documenting the Last Rod
When the drill head exits the ground or reaches the desired end position in the pit, measure and document the
length of the last rod. This will be the pipe lengthminus the length of drill rod left on the carriage. For example,
if the pipe length is 10 feet and 6 feet remain from the vice to the top of the rod, the last rodmeasurement will
be 10 – 6 = 4 feet.

The last rodmeasurement can be enteredmanually later in the LWD software after the job is uploaded. Or,
enter it now by recording the approximate length as a partial. For example:

1. At the Locate screen, hold the trigger and toggle right once to view Recording Options.

2. Toggle down and select Record a Partial Rod .
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Last Rod Measurement
1. Drill
2. Top of rod
3. 6 feet rod length left on carriage
4. Vices
5. X distance (from Rod 0 to last rod)
6. Ground surface (topography)

7. Zero elevation reference line
8. Drill head at exit (last rod)
9. Pipe length 10 feet
10. Depth
11. Relative depth (Rel. depth)

If the last rod length is 4 feet, record a half rod (5 feet), which is approximately the same. This eliminates
having to enter the valuemanually later in LWD.

Adding a Drill DataLog Survey Point
Use an optional survey point to note a difference in elevation between the entry and exit of the bore, which
provides amore accurate graph of the bore and terrain in the LWD software.

From theMainmenu, select Drill DataLog, thenAdd survey point. The survey point can also be entered
later in the Log-While-Drilling software after data upload (see Survey Point Elevation Change on page 28).

1. In theDataLogmenu , select Add survey point .

2. From the list of existing drill jobs displayed, select the job to add the survey point to.

3. Select the keypad icon.

1. Set survey point back to
unknown (see relative depth
on page 19)

2. Select keypad to enter known
elevation difference

Survey Point Menu

4. Use the onscreen keypad to enter the surveyed value for the difference in elevation between the
entry and exit of the bore.
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This keypad includes a “+/-” button, since the elevation difference can be positive or negative. The
keypad assumes the value will be positive, meaning the exit has a higher elevation than the entry. Use
the +/- button to change as needed.

5. Select Enter to set the displayed value as the survey point value. The screen returns to the
DataLogmenu.

A survey point can be added to the job later in the Log-While-Drilling software (see link above).
Setting a survey point of 0 feet will make the exit point the same elevation as the entry point. If
the survey point is not entered, it defaults to "---", (blank), not 0 feet.

Deleting a DataLog Job

1. In the DataLogmenu , scroll down and select Delete DataLog job .

2. Select the button to delete one or all jobs .

3. If deleting one job, select from the list of available DataLog jobs.

4. At the confirmation screen, select Confirm to delete orExit to cancel.

A job deleted from the receiver cannot be recovered. Ensure you have uploaded jobs you want to save to a
computer before deleting them from the receiver.
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Log-While-Drilling 3.04

Installing Bluetooth Drivers and LWD Software

Before removing an earlier version of LWD, read the section on Compatibility on page 1 for
more information.

Minimum system requirements for use of LWD software on a computer can be found under LWD Software
on page 4.

The default location for the LWD program files is c:\Program Files (x86)\DCI\DigiTrak LWD 3.04.The default
location for sample and DataLog jobs is My Documents\DCI. You can change both of these default locations
during installation or whenever you save an uploaded job.

1. Close any open applications.

2. Insert the LWD 3.04 flash drive into a USB port and view the contents of the drive.

3. Open the readme file and follow the detailed instructions.

4. Open the LWD Kit folder and double-click Drivers for LWD to install drivers.

5. Plug the Bluetooth USB radio into a USB port on your computer. If the computer is connected to the
internet, drivers may install automatically. If they don't, open the Bluetooth Driver folder on the flash
drive and double-click the *.exe file to install drivers (if you don’t see file extensions like .exe,
double-click the file of typeApplication).

6. Open the DigiTrak LWD Software folder and double-click on the setup file (setup.exe) to install the
LWD software.

After the LWD 3.04 software have been installed, a shortcut icon appears on your desktop.

Uploading Falcon F5 Data to a Computer
Uploading DataLog jobs from the Falcon F5 receiver to your computer involves adding the
Falcon F5 receiver's ID number and Bluetooth address to the LWD software’s Bluetooth device list and then
uploading the files to the computer over the Bluetooth connection.

Add Falcon F5 Receiver to LWD Bluetooth Device List
A Falcon F5 receiver must be added to the Bluetooth device list in the LWD software prior to first use.

1. Power on your computer and insert the Bluetooth USB adapter into a USB port.

2. Power on the Falcon F5 receiver and select System Information from theMainmenu.

3. The Falcon F5 serial number (ID) is on page one and the Bluetooth (BT) address is on page 2. Keep
this screen open or write these numbers down.

4. Open LWD 3.04 by double-clicking the icon on your desktop.

5. Click Bluetooth (menus View > Bluetooth Device List) to open the Bluetooth Device List
dialog box.
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1. Bluetooth Device Address
2. Bluetooth Device Name

Bluetooth Device List Dialog Box

6. Enter yourBluetooth Device Address in the specified field.

7. In theBluetooth Device Name field, enter your receiver ID number or name as desired. This is
important if you ownmultiple receivers.

8. Click Add.

9. Click OK. The device appears in the Bluetooth device list.

You are now ready to upload job data.

Uploading DataLog or White Line from a Receiver

iGPS Note

Because a White Line job is typically associated with a specific DataLog job, upload a DataLog
job first so you can open it and then import associated White Lines.

If the bore has not been drilled yet, you can import a White Line into a blank (new) LWD job.
But do not delete it from the receiver, because later after the bore DataLog has been uploaded,
the White Line can only be added to the job by importing it directly from the receiver.

1. From themainmenu, open theDataLog orWhite Lining menu. This process must be
repeated separately for each of these items.

2. Select Upload .

3. Select the job to upload. "Waiting for PC connection…" appears at the bottom of the screen.

If data isn't communicated within twominutes, the receiver returns to the DataLogmenu. Data
must be communicated to the computer within 15minutes or the receiver will power off due to
inactivity.

4. In LWD, click New (menus File > New).

5. Select DataLog orWhite Line:
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l For a DataLog, click Upload Data (menus File > Upload Control).

l For aWhite Line, click Manage GPS White Lines (menus Edit > GPS White Lines), then
Import.

1. Connection
2. Receiver name
3. Connect to Device

Upload Control Dialog Box, DataLog
or White Line

6. In the Upload Control dialog box, select Bluegiga Bluetooth Low Energy.

7. Select your receiver’s name from the Bluetooth drop-down list.

8. Click Connect to Device to begin uploading. An icon on the receiver screen shows that data is
uploading; a large data file may take up to aminute to transfer.

Low-energy Bluetooth requires that the transmitting device (Falcon F5) and the receiving
device (Bluetooth USB radio) be located within 2 feet of each other.

9. After file transfer:

l After a DataLog has been transferred, the DataLog Job Information dialog box appears. Youmay
enter the requested details now or later.

l After aWhite Line has been transferred, it is listed in theGPS White Lines dialog.

10. Click OK.

The new job data displays in the information fields and chart areas in the LWD application window.

If you created a new LWD job just for importing one or moreWhite Lines, this is a good time to save it, even
though it appears blank. Or, export the KML file, which saves it for viewing later in Google Earth, and discard
the LWD job.

White Lines are only visible when the job is exported to KML format (see page 38) and viewed
in Google Earth. White lines are not visible in LWD.

Uploading Recommendations
DCI recommends that once you are viewing your data in LWD, Save-As the file with a naming convention,
such as a "-orig" or similar suffix. Leave this file as your unedited original. Immediately Save-As the file again
with your common naming convention, without the "-orig" suffix, and use this as your working file. This
ensures that nomatter how many changes youmake to the file in LWD, you will still have an original backup
to refer to.
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If you recorded a data point using the pitch-only or blank rod option, these data points will appear to be
missing in the graph. The LWD software will make assumptions to fill in themissing data or you can choose
tomanually enter your own data (see Editing Data Points on page 31).

Opening Files
Start the Log-While-Drilling (LWD™) 3.04 program by double-clicking the LWD icon on the desktop.

A new LWD table will be blank; an LWD file with data will look like this:

DataLog with Fluid Pressure in LWD 3.04
1. Menu bar
2. Toolbar
3. Data table
4. Site information

5. Job information
6. Flags and Pins
7. Drill Profile Chart
8. Topology

9. Pitch profile
10. Drill Pressure Chart
11. Status Bar

To upload a job from your receiver, see Uploading Falcon F5 Data to a Computer on page 22.

Click Open (menus File > Open) to open an existing DataLog file. You can also open a DataLog file
directly fromWindows Explorer by double-clicking a lwd or older dl5DataLog file. See Compatibility on page
1 for more information.

Detailed information on using and editing the data fields are provided in theHelp files. Or, click the

Tooltip Helper , then click on a screen element for help with that function.



DIGITAL  CONTROL  INCORPORATED

26 DigiTrakLWD 3.04Operator'sManual

Many of the LWD menu commands are similar to those used in otherWindows programs, and some have
associated icons on the toolbar. Hover the cursor over any icon in LWD for a tooltip describing its function.
Icons or menu items that are grayed out do not pertain to the current DataLog file. See Appendix B on page
43 for a complete list of menu options and their correspondingmenu bar buttons.

The LWD 3.04 Screen
Site Information

Click Site Information , or in themenus select Edit > Site Information, or double-click in the Site
Information area shown below to edit this information.

Site Information Dialog Box

All the address and contact information for the job, client, and contractor are listed on the printed report; see
Saving, Printing, and Sending Your LWD Job on page 39 for more information. Phone numbers are excluded
from printed reports.

Site information remains from job to job to reduce the need for reentering identical data. If this
information doesn't save from job to job, particularly for versions afterWindows XP®, try this:
exit LWD, right-click the desktop LWD icon, select Properties, select theCompatibility tab,
check the box for "Run this program as an administrator", and click OK.



DIGITAL  CONTROL  INCORPORATED

DigiTrakLWD 3.04Operator'sManual 27

Job Information

Click Job Information , or in themenus select Edit > Job Information, or double-click in the Job
Information area to edit this information.

Job Information Dialog Box

The Job Information section displays statistical information about the job. Some fields may not be edited.

Rod Length Information

Default Rod Length The rod length data is included in uploads, but can be changed here if it
was entered incorrectly on the receiver.

First Rod Length This is the rod length for the first data point (rod 0), which is usually a
partial rod. This value is determined by measuring the amount of drill
rod left on the carriage from the vice to the top of the rod when rod 0 is
recorded. See step 4 on page 8.

Last Rod Length This is the rod length for the last data point, which is usually a partial
rod. This value is determined by measuring the length of the drill rod left
on the carriage from the vice to the top of the rod and then subtracting
this distance from the rod length. For example, if the length of rod left
on the carriage is 6 feet, and your rod length is 10 feet, the last rod will
measure 4 feet (10 – 6 feet). SeeMeasuring and Documenting the Last
Rod on page 19.

Receiver Information

Serial Number The Serial Number Serial number (ID) of the receiver.

Date Format This corresponds to the first uploaded data point.

Job ID The number assigned to the job in the receiver.

Data Points The number of data points collected (includes manually inserted data).
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Survey Point Elevation Change

Do Not Use Reference
Elevation

Normally, leave this box checked. Clear this box to enter a reference
elevation in the field below it.

Reference Elevation This is the true elevation of the X axis above sea level. This value is
not used in calculations; it is only noted on the Job Information report
and the title of the chart.

Relative Elevation at Entry The vertical distance from the zero elevation reference line to the drill
head when it cannot be positioned at the zero elevation line.

Do Not Use Exit Survey Point Selected by default, this box causes the exit elevation to be calculated
based on the pitch, rod, and depth data only.

Relative Elevation at Exit The positive or negative difference between the entry and exit
elevations. Enter a negative value if the exit is lower than the launch;
do not use a + symbol for a positive value. This information can be
captured on the receiver by setting a Survey Point (see page 20).

General Information

Name Enter an optional job name.

Work Order # Enter an optional job work order number.

Comments Enter optional job comments.

Entry (GPS) TheGNSS coordinates of the entry (comes from LWD Mobile).

Exit (GPS) TheGNSS coordinates of the exit (comes from LWD Mobile).

Accounting for Entry Pit Depth
If the drill head starts in an entry pit, enter the depth of the drill head in the pit in theRel. Elev. At Entry field
of the Job Information screen.

Data Table
The data points table displays all data points in the job in sequential order, along with their associated data.
Depth and pitch units display in the job information box. Within this table you can insert, edit, delete, hide, or
remove individual data points.

Data Table

This diagram on page 20 shows where each of these datameasurements occur on a bore path.
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Rod ID Rod number and status of the data point. A colored flag is displayed to
indicate the status of the data:

l Red Flag: Pitchmissing; enter pitch for the bore path to be
calculated correctly.

l Magenta Flag: Depthmissing; highlights pitch-only data points for
the operator. Open the Edit Data Point dialog box and click OK to
restore this flag to either blue or green depending on the data
entered by the operator for depth.

l Blue Flag: Data point has been edited
l Gray Flag: Data has been hidden or removed
l Green Flag: Overwritten data
l Black Flag: Original data

Rod Len. (Rod Length) The length of the rod.

Bore Len. (Bore Length) The length of the bore (sum of all the previous rod lengths
plus the current rod length).

X Dist. (X Distance) The horizontal distance from the entry.

Pitch The pitch value recorded at the specified data point.

Rel. Depth (Relative Depth) The depth of the drill head below the zero elevation
line.

Depth The distance from the drill head to the terrain surface. This can be
measured, enteredmanually by the user, or interpolated by the LWD
software based on inserted or missing data.

Rel. Elev. (Relative Elevation) The positive or negative difference from the Zero
Elevation Line.

L/R Offset (Left/Right Offset) The horizontal distancemaintained left (L) or right
(R) from a feature beside the bore path, such as a curb, guardrail, or
surveyed path.

Deviation How far the drill head deviated from the intended bore path.

Date/Time The date and time the specified data point was recorded. This
information will not appear on the printed report. The date/timemust be
set correctly on the receiver for this information to be accurate.
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Type Information regarding the type of data recorded at the data point:

l BL: Blank (no pitch, depth, or GNSS data)
l PO: Pitch Only (no GNSS data)
l LL: Locate Line
l FLP: Front Locate PointGNSS data is automatically hidden;
right-click to unhide. GNSS X Distance) (see page 20) will be
positioned beyond the drill head.

l IN: Inserted data point. Pitch and depth defaults are interpolated
from adjacent data and not displayed by default. This data can be
modified if required by overwriting the default values listed. The
new data point is listed alphabetically (such as, the first point
manually inserted after rod number 2 is listed as 2-A, the second as
2-B, etc.).

RawDepth The depth reading on the receiver at the FLP (projected depth) or LL
(depth). Raw means "without any corrections applied".

RawDist An amount of correction. Added to X Distance, this value yields where
the LL or FLP is in relationship to the drill head plot for the rod. The
horizontal distance from where a data point was taken to a point
directly above the transmitter. Raw means "without any corrections
applied".

Avg. Pres. (Average Pressure) See Drill Pressure Data Points on page 34.

High Pres. (High Pressure) See Drill Pressure Data Points on page 34.

Max Pres. (Maximum Pressure) See Drill Pressure Data Points on page 34.

Latitude The latitude reading provided by the optional iGPS module.

Longitude The longitude reading provided by the optional iGPS module.

GNSS X Dist. (GNSS X Distance) (see page 20) X Distance plus RawDist.

Comment Any comments on individual data points can be added to show in this
column (see Edit Rod/Data Point below).

iGPS Note

With the iGPS module, lat/long is included for data points taken at the locate line (LL). Lat/long
will be blank for data points taken at the FLP or recorded as pitch-only or blank. Lat/long data
that is blank due to being recorded at the FLP can be unhidden by right-clicking the data row and
selecting Unhide GNSS. In the same way, right-click a row to hide lat/long data if desired.

Without the iGPS module, latitude and longitude (lat/long) data will always be "n/a".
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Symbols in the data points list identify different types of data:

o data overwrittenmanually

e rod length edited

i data interpolated

f data filled in; datamissing in original upload

h data hidden

x pitch datamissing

Editing Data Points
Right-click a data point in the table to open a pop-upmenu with the options to Edit, Insert, Delete,
Hide/Unhide, Hide/Unhide GNSS, and Remove.

Data Point Table Shortcut Menu

Edit Rod/Data Point

Right-click the data point and select Edit, or simply double-click a data point in the list or on the chart. Edit
the data or add comments as required. Click OK to save changes, orCancel.
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1. Rod length in same units as
depth measurement

2. Box is automatically checked
if blank rod is recorded or
inserted

3. Box is automatically checked
if blank or pitch-only rod is
inserted

Edit Data Point Dialog Box

If a blank data point exists, thePitch is Missing/Unknown check box is selected by default. If you don’t
enter the correct pitch value and uncheck the box, there will be a gap in the pitch profile line on the chart. The
missing data point will be emphasized on the chart. See ResolvingMissing Data on page 12.

If a new rod is inserted or a blank or pitch-only data point is recorded, theDepth is Hidden/Unknown check
box is selected by default. If you don’t enter the depth value and uncheck the box, there will be a gap in the
topology line on the chart and themissing point will not be shown.

To restore original recorded data, click theRestore Default button next to the data to be restored.

Insert Rod/Data Point

Right-click the data point prior to where the new data point is to be inserted and select Insert. A new data
point appears in the data list and on the chart.

The new data point will be numbered the same as the one prior to it with a letter appended. For example, the
first point manually inserted after rod 2 will be listed as 2-A, the second as 2-B, and so on. The values listed
for pitch and depth are interpolated from adjacent data, and depth is hidden by default. The rod type will be
listed as IN for inserted data. Youmay change data values as needed. To restore original interpolated data
values, click Restore Default under the corresponding data field.

Delete Inserted Rod/Data Point

Right-click the data row to be deleted and select Delete. The data point is removed from the data points list
and from the chart.

Original data cannot be deleted. If a rod is unintentionally recorded twice, select Remove to remove that data
point.
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Hide

When this option is selected, the data point still appears in the data list but it is hidden on the chart. The data
is still included in the calculations. A check mark is placed next to the option on the pop-upmenu and is
visible the next time this rod is edited.

Remove

Select this option to remove the data point from the list, chart, and calculations. Use this option on original
data that was unintentionally recorded twice.

Drill Profile and Drill Pressure Charts
TheDrill Profile chart graphically displays the data contained in the table. Hidden or removed profile data
points will not display in the chart area. The profile chart will show points if they are hidden, but not if they are
removed. Data resides in its ownDrill Pressure chart at the bottom of the LWD window, separate from drill
profile data but with each data point rod-aligned to correlate with the drill profile.

Hover the cursor over any graphical data point, flag, or pin to display details. Double-click data points or a
row in the data table to view and/or edit the data. Click anywhere in the chart to make the table show data for
that portion of the chart.

Data Points Data points that have not been hidden or deleted.

Values The value of the points contained in the chart area.

Cursor Coordinates Place the cursor anywhere on the chart area to see the value of the
coordinates at that point. Place the cursor on a data point to display
data values recorded at that point.

Zoom In/Out Hold the Ctrl key and drag the pointer through an area to zoom in. To
return to normal scaling, Ctrl+click anywhere in the chart area.

Flags and Pins Located along the top of the chart.

Drill Profile Data Points

Drill Profile Chart

Green The calculated topographical profile of the bore. These points can only
be edited for depth, after which they will also be highlighted.

Blue The calculated bore based on rod length and pitch readings.

Highlighted Points with a green circle behind them indicate rods have been deleted
during the data collection process.
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Drill Pressure Data Points

Drill Pressure Chart

Max Pres. Themaximum pressure recorded during the job up to when this data
point was recorded, including deleted rods.

High Pres. The high pressure recorded during the job up to when this data point
was recorded, including deleted rods. This is the average plus one
standard deviation—this includes 84% of the pressure readings
(assuming a normal distribution). Statistically, there will have been
occasional spikes above this pressure.

Avg. Pres. The average pressure recorded during the job up to when this data point
was recorded, including deleted rods.

Drill pressure data is collected at the rate of approximately one sample every four seconds. Drilling slowly
will result in more data points per rod. The number of data points collected per rod is shown on the printed
report data table under theNum Samples column (see sample printed drill fluid data table in Appendix C on
page 50).

LWD provides seamless interaction between the drill profile and drill pressure charts and the tabular data.
Hover over a data point to display detailed information collected at that point. Click a data point on the drill
profile chart to display its corresponding row in the data points table; this makes it especially easy to align a
data point on a chart for jobs that exceed 50 rods. Gaps in the charted data points will appear when data is
missing or removed (but not when hidden). Sometimes hiding a data point on the chart helps show other
elements, such as a utility flag. A data point hidden on the profile chart will still display in the data points list.

Each chart has its own coloring scheme for the displaying of data points.

Drill pressure data cannot be deleted. If an overpressure event was recorded during a rod that was
subsequently deleted, it will bemerged into the data of the next recorded rod. The data from that entire rod
can be removed.

Utility Flags

Use utility flags to show the location and type of utilities on the chart and printed report. To add or edit utility

flags, click Edit Utility Flags (menus Edit > Utility Flags) to open the Utility Flags dialog box. Or,
position the cursor at the desire location on the graph and Shift+click.
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Utility Flags Dialog Box

Type Select from the drop-down list. The flag will appear on the chart as a
circle using APWA (American Public Works Association)
recommended colors.

X Dist (Distance) The horizontal length on the surface of the ground from the entry to the
utility.

Depth The vertical length from the surface to the utility.

Comment The default caption is the type of utility; enter a comment to create a
new caption.

Text Slope The angle of the caption text on the chart.

Editing and Annotating Charts
Charts can be edited and annotated in a number of ways.

Define Chart Properties
Under theEditmenu, use one of theProperties commands to change chart edges and scale. Or, click

Profile orPressure chart in the toolbar. It is advisable to set both Profile and Pressure charts to the
same horizontal edges so their data lines up with each other. To hide a graph, set all edges to zero.

Profile Chart Properties Dialog Box
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Add Annotations
UseAnnotations to define shapes and captions to appear on charts to describe job site conditions and other
points of interest.

To draw shapes directly on the chart, position the cursor at the desired location on the graph, hold the Shift
key, and drag themouse. When you finish, the Annotations dialog box includes the location coordinates of
the box.

Alternatively, click Profile orPressure chart in the toolbar (both also in theEditmenu) to open the
Annotations dialog box first and enter location coordinates manually.

1. Define box boundaries and
other properties in this
section

2. Click to add
3. Click to save and exit

Annotations Dialog Box

Double-click an existing annotation to change its properties (captions cannot be edited in this manner, only
objects).

Select aShape to add from the drop-down box. Adjust the Line Weight and Font Height as needed. Use
the check boxes and double-click the ellipses in theDraw Shape section to set shape properties and colors.

Select theDraw Caption check box to activate the Caption section. A caption does not require a shape.
Captions appear centered in the shape by default. To change the location or orientation of caption, use the
Top - Left and Text Slope fields.

Click Add to add the annotation to the list, thenOK to save and exit.
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Edit Flags and Pins

To edit, hide, or comment on flags and pins, select Edit > Flags and Pins, or click .

Flags and Pins Dialog Box

To add or edit a flag or pin comment, select a pin or flag, enter or edit text in theComment field, then click
Edit comment to save it.

To hide a flag or pin from a printed report, select it and click Hide. the X Dist. value is now preceded by h. To
show a hidden flag or pin, select it and click Show.

To close this window, click OK.

Rod ID The rod number

Number The number of the flag or pin

Type Flag or pin

X Dist. The horizontal distance along the bore from the entry (see diagram on
page 20).

Rod Rel. LR The distance the rod is left or right of the featuremarked with a pin. Not
applicable to flags.

Comment User-entered comment
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Viewing GNSS Data on Google Earth

When you open your DataLog in LWD 3.04, you have the option of viewing the bore as aGoogle Earth map
overlay. To view your bore onGoogle Earth, do the following:

1. Install Google Earth on your computer. Go to https://www.google.com/earth/.

2. In LWD 3.04, open the desired job.

Optional: If you haven't yet added an existingWhite Line to the bore, see Uploading DataLog orWhite
Line from aReceiver on page 23 to do so, then save the job.

3. Select File > Export to KML....

4. Use the suggested file name or create your own, select your desired destination folder, and click
Save. This creates a separate KML file containing GNSS rod-by-rod data and all White Lines
imported into this job.

5. Locate the kml file on your computer and double-click to open in Google Earth.

TheGoogle Earth interface has several options for moving around themap, changing views, and editing
viewing preferences. Please refer to the Google Earth application Help for details.

The following table lists some common functions.

To Do this

Move the map Drag themap

Rotate the map Ctrl+mouse wheel

Zoom in/out Use the onscreen + and - buttons on the right of the screen, or the
slider between them

Print the map Click the Print icon

Save the map Click the Save icon

Use street-level view Drag the orange person icon above the zoom control to a point on the
map; to exit, click the "Exit Street View" button at the top right of the
screen

Change direction in street
view Drag themap

Move in street view Click themap near the left or right edge

Google Earth provides minimal editing abilities that allow you to remove or hide a latitude/longitude point, but
hiding or showing the GNSS point in LWD 3.04 prior to saving the KML file may produce better results.

https://www.google.com/earth/
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Removing White Lines
To view the bore in Google Earth without White Lines or other elements, expand the Places menu at the left
of the Google Earth screen:

Select or clear boxes as desired to show or hide different elements on themap.

Saving, Printing, and Sending Your LWD Job
Saving Project Files

To save your project, click Save (menus File > Save). If the file has already been saved, it will re-save
under its current file name and location. If the file has not yet been saved, name the file and select the save
location in theSave As dialog box, then click Save.

The default file name for DataLog drill data in LWD 3.04 is DrillData#.lwd, where # represents a number that
starts at 1 and advances automatically as files are saved. Data exported in KML format contains only GNSS
data for viewing in Google Earth and has a kml extension instead of lwd.

To save an open file with a different file name or location, select File > Save As. Change the file name and
location as desired, then click Save.

To export a comma-separated value (*.csv) Unicode text file for use in a spreadsheet, click Export

Spreadsheet (menus File > Export Spreadsheet).

DCI recommends saving a copy of each job as a backup as soon as you open it. See Uploading Falcon F5
Data to a Computer on page 22.

Printing and Previewing Project Files

To print job data, click Print (menus File > Print). DCI recommends selecting Landscape orientation
using theProperties button.

To preview pages before printing, click Print Preview (menus File > Print Preview). On the preview
window, click Print to reach the print dialog box orClose to return to the file. If the printed scale appears
awkward, see Editing and Annotating Charts on page 35 for how to change chart edges and scale.

To edit printing properties such as the printer, paper size, and paper orientation, click Print Setup
(menus File > Print Setup).

Page one of the print job contains job information such as location, client, and contractor information, along
with the statistical data about the job and job comments. Page two contains profile and plan view charts.
Page three and beyond list topography survey data and drill data. Deleted data points will not display.
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Sending Project Files

Your LWD 3.04 project file can be opened by anyone who also has the DigiTrak LWD 3.04
software. LWD 3.04 can also open jobs saved in prior versions of LWD. See Compatibility on
page 1 for more information.

To send a report to a customer who does not have the LWD software, install a PDF print driver , then print to
this “printer” to create an electronic report viewable on any PDF reader.

As an alternative to PDF, Microsoft Windows systems include a “Microsoft XPS Document Writer” in the list
of available printers. Your customer will require Microsoft Internet Explorer to read this encapsulated
postscript (XPS) format without an XPS reader. Please refer to http://www.microsoft.com for additional
information on using this format.

Once you have your preferred PDF writer installed (or if you are using the XPS writer):

1. Click Print (menus File > Print).

2. Use theName drop-down list to select your PDF writer or Microsoft XPS Document Writer.

1. Select printer/writer
2. Select landscape orientation

here

Profile Chart Properties Dialog Box

3. Click Properties, select landscape orientation (recommended), and click OK to save the
orientation and close theProperties dialog box.

4. Click OK to print (generate) the file.

5. Choose the folder where you want to save the file and enter a File Name.

6. Click Save.

Depending on your print settings, youmay automatically see the generated PDF file, or youmay need to find
and open it to see it. Most users will find it convenient to send the PDF file to their customer as an
attachment to an email.

File Location
The default location for sample and DataLog jobs is /My Documents/DCI.

http://www.microsoft.com/
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Appendix A: Receiver DataLog Icons

Symbol Description

Add Survey Point – Records a surveyed value for the difference in elevation (reference elevation)
between the start and end of the bore. This value will help provide a more accurate profile graph
in the LWD software.  Page 20

Append to an Existing Job – Continues adding data to an existing DataLog job. Select the job
number from the list.  Page 17

Close Job – Saves and closes a DataLog job. A job can be viewed, appended to, and uploaded
until it is deleted from the job list.  Page 16

Confirm Delete – Appears after a request to delete jobs to confirm the deletion. Select to confirm
deletion or select Exit to cancel deletion.  Page 21

Create a New Job – Starts a new DataLog job. You will be prompted to set up the job with rod
lengths.  Page 8

Delete All Jobs – Deletes all jobs stored in the receiver.  Page 21

Delete Job – Deletes the selected DataLog job(s) from the receiver. Also used in the Delete Job
menu to select one job to delete.  Page 21

Enable / Disable DataLog – When “Enabled, click to disable” shows, the icon is green, the
DataLog function is enabled, and you can access DataLog menu options at the Locate screen.
When “Disabled, click to enable” shows, the icon is red, the DataLog function is disabled, and no
logging will occur.  Page 7

Pause Job – Opens the receiver’s Main menu but keeps the job open with no data recording.
Data continues recording on the current job number when you re-enter the Locate screen without
powering the receiver down.  Page 16

Record a Blank Rod – Logs a data point with no pitch or depth information; use when the receiver
cannot be positioned within range of the transmitter.  Page 12

Record a Partial Rod – Logs a data point after finishing a partial rod. Recommended when using
long drill rods during significant pitch changes or to accurately plot small changes in
topography.  Page 12

Record Depth/Pitch – Logs the depth and pitch information at a front locate point (FLP) or locate
line (LL) data point. This option is unavailable at the first rod data point and when pitch or depth
information is not available. The green lights indicate GNSS signal quality when the iGPS module
is installed.   Page 12

Record Depth/Pitch with iGPS Module Installed – Same function as above, but the green lights
indicate GNSS signal quality when the iGPS module is installed. These lights match the three
solid rightmost lights on the iGPS module.  Page 12



DIGITAL  CONTROL  INCORPORATED

42 DigiTrakLWD 3.04Operator'sManual

Symbol Description

Record Pitch Only – Logs only the pitch information at a data point; use when the receiver cannot
be positioned over the FLP or LL. This option will be unavailable if pitch information is not
available, in which case you must record a blank rod.  Page 12

Set a Flag – Set a flag when crossing an item of interest along the bore path, like a sidewalk,
marked utility line, or river bank.  Page 14

Set a Pin – Set to mark the location of a land feature to the left or right of the bore, such as a fire
hydrant or power pole, that can help locate the bore path later.  Page 15

Set Up Job – Sets up a new job or appends data to an existing job. Only accessible when
DataLog is enabled. If no Drill DataLog job has been started, this option can also be accessed
from the Locate screen by holding the trigger and toggling right.  Page 8

Upload Job – Uploads DataLog jobs to a computer with DigiTrak LWD software installed. The
receiver can store a maximum of 50 DataLog jobs.  Page 22

View DataLog – Displays data for a specific job.  Page 18

View/Delete Rod Data – Shows all logged data points; lets you delete the last logged data
point.  Page 18
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Appendix B: Menus

Many of the LWD 3.04menu commands are similar to those used in otherWindows programs, and some
have associated icons on the toolbar. Point the cursor at any icon in LWD for a tooltip describing its function.
Icons or menu items that are grayed out do not pertain to the current DataLog file. Page numbers below refer
to the first page the command is mentioned in this manual.

File Menu
Symbol Icon Description

New Create a new job (drill data, pressure-tension, or steering). Once a
selection is made, a new blank job screen appears.  Page 23

Open Open an existing job.  Page 25

Close – Close the current job.

Save Save an open job. If the job has not yet been named/saved, this
opens the same dialog box as Save As.  Page 39

Save As – Save the current job to a specified file name and folder.  Page 39

Print Setup
Select options such as a printer, paper size and orientation. These
options are usually also available on a Windows Print dialog box
under a button called Properties.  Page 39

Print Preview Display the job onscreen as it will appear printed.  Page 39

Print Print the job.  Page 39

Export Spreadsheet Export a comma-separated value (*.csv) text file for use in
spreadsheet software.  Page 39

Export to KML – Export the job to the KML format for viewing in Google Earth.  Page 38

Upload Control Link to a DigiTrak receiver to upload files.  Page 22

File 1, 2... – Open a recently opened file.
Exit – Exit DigiTrak LWD 3.0.

Edit Menu
Symbol Icon Description

Site Information
Enter and edit the location, contact information, and comments that
display in the Site Information box in the upper left corner of the
program. Shortcut: double-click the site information box.  Page 26

Display Units
Select the depth, pitch, temperature, and pressure units displayed on
the LWD charts. The depth unit setting in the receiver will determine
the units displayed.  Page 25

Job Information

View and edit job details including rod length, survey point
information for drill data files, and information about the product being
installed for pressure-tension files. This dialog box displays
immediately after uploading a DataLog file. Shortcut: double-click the
Job Information box.  Page 27
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Symbol Icon Description

Utility Flags Add, change, or delete flags and data regarding utilities.  Page 34

Flags and Pins Edit, hide, or comment on flags and pins.  Page 37

GPS White Lines Import or delete White Lines.  Page 23

Profile Chart Annotations Make comments and insert drawings to appear on the profile chart.
Shortcut: Shift+drag a box on the chart.  Page 35

Pressure Chart Annotations Make comments and insert drawings to appear on the pressure chart.
Shortcut: Shift+drag a box on the chart.  Page 35

Profile Chart Properties Adjust the scaling of the profile chart.  Page 35

Pressure Chart Properties Adjust the scaling of the pressure chart.  Page 35

View Menu
Symbol Icon Description

Toolbar – Show or hide the toolbar.
Status Bar – Show or hide the status bar.

Bluetooth Device List Show a list of registered Bluetooth devices.  Page 22

Window Menu
Symbol Icon Description

NewWindow – Open the current file in a new window.
Cascade – Arrange windows in an overlapped fashion.
Tile – Arrange windows in non-overlapped tiles.
Arrange Icons – Arrange icons of minimized windows.
Window 1, 2... – Go to specified window.

Help Menu
Symbol Icon Description

Help Topics An index of Help topics.  Page 25

About DigiTrak LWD – Displays the version number of the DigiTrak LWD software.
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Appendix C: Sample Printed Output
Customer Data
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Drill and Pressure Graphs
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Data Table
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Flags and Pins

Data from an iGPS module would appear in the Latitude, Longitude, GNSS Time, andGNSS X Distance columns.
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Flags and Pins (continued)

Note the comments added to the Pin at Rod 41.
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Fluid Pressure Table
This report will only generate if fluid pressure data is available.
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DCI StandardWarranty 1

DCI Standard Warranty

DCI warrants that it will either repair or replace anyproduct that fails to operate in conformity to DCI’s published specificationsat the time of
shipment due to a defect in materials or workmanship during the warranty period for that product, subject to the termsset forth below.

Category Warranty Period

Falcon Transmitters (19” and 15”) Three years fromdate of purchase or first 500 hours of use, whichever occurs first.

All Other Transmitters Ninety days fromdate of purchase

Receivers, Remote Displays, Battery
Chargers and Rechargeable Batteries One year fromdate of purchase

Software* One year fromdate of purchase

Other Accessories Ninety days fromdate of purchase

Service/Repair Ninety days fromdate of repair

* For software products, in lieu of the warranty set forth above, DCI warrants that it will either update any defective software to bring it into material
compliance with DCI’s specifications for such software, or refund the purchase price paid for the software.

Terms
l The 3-yr/500-hr warranty period for a Falcon transmitter is conditioned on registration of the purchase with DCI within 90 daysof the date of

purchase. If the customer fails to register the purchase during this time frame, the warranty period for the transmitter will instead be ninety
days from date of purchase.

l Warranty coverage for a warranty replacement transmitter shall tie back to the original transmitter(s) submitted for warranty coverage. For
example, if a Falcon transmitter is owned for one year and used for 250 hours, the warranty coverage for the replacement will be an
additional two years or an additional 250 hours of use, whichever comes first.

l “Hours of use” for purposesof the Falcon transmitter warrantymeansactive run-time hours, asmeasured internally byFalcon transmitters.

l In the event of a valid warranty submission, the choice of remedy (for example, to repair or replace a defective product or, in the case of
defective software, to update or refund), shall be at DCI’s sole discretion. DCI reserves the right to use remanufactured replacement parts
for repairs.

l The above warranties only apply to new products purchased directly fromDCI or from aDCI-authorized dealer.

l The ultimate determination of whether a product qualifies for warranty replacement shall be at DCI’s sole discretion.

Exclusions
l Transmitters that have exceeded themaximum temperature, as indicated by the system.

l Defect or damage caused bymisuse, abuse, improper installation, improper storage or transport, neglect, accident, fire, flood, use of
incorrect fuses, contact with high voltagesor injurious substances, use of system components not manufactured or supplied byDCI, failure
to follow the operator’smanual, use other than that for which the product was intended or other events beyond the control of DCI.

l Any transmitter used with an improper housing, or damage caused to a transmitter from improper installation into or retrieval from a
housing.

l Damage during shipment to DCI.

Anymodification, opening up, repair or attempted repair of a product, or any tampering or removal of any serial number, label or other
identification of the product, will void the warranty.

DCI doesnot warrant or guarantee the accuracyor completenessof data generated byHDD guidance/locating systems. The accuracyor
completenessof such datamaybe impacted bya variety of factors, including (without limitation) active or passive interference and other
environmental conditions, failure to calibrate or use the device properly and other factors. DCI also doesnot warrant or guarantee, and disclaims
liability for, the accuracyand completenessof anydata generated byanyexternal source that maybe displayed on a DCI device, including
(without limitation) data received from a drill rig.

mailto:dci@digital-control.com
http://www.digitrak.com/
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DCImaymake changes in design and improvements to products from time to time. DCI shall have no obligation to upgrade anypreviously
manufactured DCI product to include any such changes.

THE FOREGOING IS THE SOLE WARRANTY FOR DCI PRODUCTS (OTHER THAN THE 5-YR/750-HR EXTENDED WARRANTY FOR
FALCON 15/19” TRANSMITTERS). DCI DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT
LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, IMPLIED
WARRANTY OF NON-INFRINGEMENT, AND ANY IMPLIED WARRANTY ARISING FROM COURSE OF PERFORMANCE, COURSE
OF DEALING, OR USAGE OF TRADE, ALL OF WHICH ARE HEREBY DISCLAIMED.

In no event shallDCI or anyone else involved in the creation, production, sale or delivery of the DCI product (“partners”) be liable for anydamages
arising out of the use or inability to use the DCI product, including but not limited to indirect, special, incidental, or consequential damages, or for
any cover, loss of information, profit, revenue or use, based upon any claim for breach of warranty, breach of contract, negligence, strict liability, or
anyother legal theory, even if DCI hasbeen advised of the possibility of such damages. In no event shallDCI or its partners’ liability exceed the
purchase price for the product.

Thiswarranty is not assignable or transferable. Thiswarranty is the entire agreement between DCI and purchaser, andmaynot be expanded or
amended in anywayother than in writing byDCI.

Product demonstrations
DCI personnelmaybe present at a job site to demonstrate basic usage, features, and benefits of DCI products. DCI personnel are present only to
demonstrate a DCI product. DCI doesNOT provide locating servicesor other consulting or contracting services. DCI doesnot assume anyduty to
train the user or anyother person, and doesnot assume responsibility or liability for the locating or other work performed at a job site at which DCI
personnel or equipment are or have been present.


	Important Safety Instructions
	Compatibility

	Falcon F5 DataLog
	Introduction
	How It All Works
	DigiTrak DataLog Management (DDM)
	Setting Time and Calendar
	System Components
	Receiver
	Transmitter
	LWD Software
	Bluetooth USB Radio
	Typical LWD Report


	Using DataLog on Falcon F5
	Enable DataLog
	Receiver DataLog Menu
	Create a New Job
	Resolving Missing Data

	Recording Partial Rods
	Flags and Pins
	Offset and Deviation
	Closing or Pausing a Job
	Appending to an Existing Job
	Viewing and Pulling Back (Deleting) Rods from the Receiver
	Measuring and Documenting the Last Rod
	Adding a Drill DataLog Survey Point
	Deleting a DataLog Job

	Log-While-Drilling 3.04
	Installing Bluetooth Drivers and LWD Software
	Uploading Falcon F5 Data to a Computer
	Add Falcon F5 Receiver to LWD Bluetooth Device List
	Uploading DataLog or White Line from a Receiver
	Uploading Recommendations

	Opening Files
	The LWD 3.04 Screen
	Site Information
	Job Information
	Accounting for Entry Pit Depth
	Data Table

	Editing Data Points
	Drill Profile and Drill Pressure Charts
	Editing and Annotating Charts
	Define Chart Properties
	Add Annotations
	Edit Flags and Pins


	Viewing GNSS Data on Google Earth
	Removing White Lines
	Saving, Printing, and Sending Your LWD Job
	Saving Project Files
	Printing and Previewing Project Files
	Sending Project Files
	File Location


	Appendix A: Receiver DataLog Icons
	Appendix B: Menus
	File Menu
	Edit Menu
	View Menu
	Window Menu
	Help Menu

	Appendix C: Sample Printed Output
	Customer Data
	Drill and Pressure Graphs
	Data Table
	Flags and Pins
	Fluid Pressure Table


